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***IMPORTANT NOTE*** 

Do not post files if there is no email. 

Verify with CSR & request approval email to be sent 

Posting Files for Production 
1.  Verify job is approved 

a. Open Microsoft Outlook 

i. Locate approval email 

1. Search Job# 

2. Locate “APPROVED” within Subject line 

ii. Confirm that approval email has been received 

2. Open job folder 

a. Locate the job folder within F:\CV1\5664234\Job# 

3. Locate press subfolder 

a. INDIGO OUTPUT 

b. VWEB 

c. INKJET 

d. LASER 

e. DP100 

4. Depending on which press, go to the following locations: 

Indigo Y:\ 

vWeb \\10.0.0.62\Job_Submission\uploads  

Inkjet U:\DP-Inkjet  

DP100 U:\DP-Inkjet 

Laser \\bp-file01\Groups\InterDeptFolders\DP-Laser 
 

5. Locate/Create subfolder with “Job#” 

6. Copy and Paste files into subfolder in the desired location 

7. Reply to Approval Email 

a. Include: 

i. CSR 

ii. Brooklyn Park OK 

iii. Lettershop Approval 

b. Notify that files have been posted. 

8. Update job status in Smartsheet to “COMPLETE” 
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Job Scheduling 
Review Scheduling  

1. Login to Smartsheet 

2. Go to the Data Processing Schedule sheet 

a. WORKFLOW 2.0 Workspace > Schedules folder > Data Processing Schedule 

i.   
3. Review jobs list 

a.  
4. Balance workload based on quantity, estimated hours, and skill level 

a. Reference Data Processing Dashboard within Smartsheets for graphs expressing 
workloads 

i.  
5. Choose an unassigned job 

a. Prioritize earliest due dates 

b. Select based on skill level 

6. Within the DP Operator column, select the operator accordingly 

 
 

file://bp-file03/DP_Production/dp/g2v1/CV1/5664234
file://bp-macfile02/PremediaJobs/
file://10.0.0.62/Job_Submission/uploads
file://bp-file01/Groups/InterDeptFolders/DP-Inkjet
file://bp-file01/Groups/InterDeptFolders/DP-Inkjet
file://bp-file01/Groups/InterDeptFolders/DP-Laser
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Posting Files 

Posting Files for CSR 
1. Verify the following has been completed: 

a. SSOE 

b. Postal Review 

c. Alterations 

2. Determine where files are to be posted: 

a. J:\Explicit_Access\Customer\Data\_From_DP\Job#_REPORTS 

b. J:\Open_Access\Customer\Data\_From_DP\Job#_REPORTS 

i. Server location will be determined by where data was picked up 

1. Specified on job ticket within Covert file(s) Instructions 

 
3. Locate files to be posted 

a. F:\CV1\5664234\Job#\Job#_REPORTS 

4. Verify all reports requested on job ticket are within subfolder 

a.  
5. Copy all contents 

6. Paste into location determined in Step 2 
  

**NOTE**: SSOE/Postage emails should contain links to locations for where the files 
are to be posted and specify where the files are to be posted.  

However, it is still best practice to reference the job ticket to ensure correct locations 
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Job Initiation 
Review Job Ticket 

1. Ensure all information needed for data processing is available and understandable 

a. Look for missing/conflicting information 

2. Review due date/time 

a. Alert CSR and/or DP Manager/lead if any concerns 

3. Discuss any discrepancies or concerns with first with experienced team member or manager/lead 

4. If there are still questions, notify CSR via email 

a. Use QUESTION --> JOB# | CUSTOMER | DESCRIPTION in the subject line of the email  

i. Cc: DataProcessing-BP  

ii. Be concise and as clear as possible 

b. If you verbally have discussions, send follow-up email to document the conversation. 

c. Request CSR to add any pertinent instructions to job ticket that you feel is necessary 

Create Job Folder 
1. Run JOB_INITIATOR.bat 

a. Enter Job Number followed by the enter key 

i. Job folder will be created 

2. Select any key to continue 

a. Closes the .bat file 

Collect Job Resources 
1. Pick up data/art 

a. Identify location of resources on job ticket 

b. Follow the path location and collect all files needed 

i. J:\Explicit_Access 

ii. J:\Open_Access 

c. Copy files into job folder ORIGINALS folder 

d. Copy any art files into DP_ART folder 

e. Save data files into DATA_IN folder 

i. Save as delimited (tabbed/comma) 

 
 

file://bp-servuftp/glsftp/Explicit_Access
file://bp-servuftp/glsftp/Open_Access
file://bp-file03/DP_Production/dp/g2v1/CV1/5664234
file://bp-servuftp/glsftp/Explicit_Access
file://bp-servuftp/glsftp/Open_Access
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5. SSOE not required unless new data/art files supplied 

6. Post files for CSR 

a. Posting Files 

7. Send Email & Notify CSR 

a. To:   CSR 

b. Cc:   Data Processing-BP 

c. Subject: AA EDIT COMPLETE -->JOB | CUSTOMER | DESCRIPTION 

d. Message: New files located at:  

{Add link to location where new SOF contents are to be posted for CSR} 

8. Update Smartsheet 

a. Status = SIGNOFFS SENT 

b. MOVE ROW = CSR 

9. Punch out of job 
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Tracking of Time 

Time Tracking 
1. Launch Shopfloor BP DP  

a.  
2. Login with your credentials  

a. Select the Keyboard for Bar Code Input  

i.  
b. Type “E” followed by your employee number: 

i.  
3. Clock-in/out  

a. Start/End shift 

b. Client jobs 

c. Non-client jobs/Idle time 

d. Lunch Breaks 

4. Clock in by clicking Select a Center to Work In button 

a. If non-client job or idle time, select Data Processing 01 

i. Select an Unlisted Job 

ii. Select check mark button 

iii. Select Station 

iv. Select desired cost center 

1. QC Non Chargeable 
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Additional Alterations 
Alteration Requests 

1.  Confirm alteration is indicated 

a. View in Smartsheet 

i. Task contains “ALT” 

ii. Row should be highlighted orange 

  
b. View on Job Ticket 

i. Locate “ALTERATIONS” section 

ii. Review instructions for requested ALT 

 
2. Punch into job 

a. Reference: Time Tracking 

b. Select “Charge Type” specified in instructions on job ticket 

i. Author – Customer Edit 

ii. Rework – Department Edit 

3. Perform appropriate steps to complete alteration requested 

a. Consult an additional team member for extra guidance if needed 

4. Output all new files 

a. Reference: Inspire Designer Output 

b. Be sure to update revision number accordingly 
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b. If client job, select Data Processing 01 

i. Select an Unlisted Job 

ii. Type in Job# within the Input #: field 

iii. Select check mark button 

iv. Select Station 

v. Select General Programming 01 

5. Clock in/out for lunch breaks 

a. Select Start Break to begin break 

b. Select End Break to end break 

6. Clock out of client/non-client jobs 

a. Select Your Started Activities 

b. Select desired activities 

c. Select flashing “Selected” button 

d. Add any comments if necessary 

i. Add “SSOE” if performing SSOE for the job 

e. Select End button 

f. Select “Yes” for another transaction 

i. This will allow you to bypass punching in your number every time 

7. Clock out of shift 

a. Select End Shift button 
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Postal Review 
Sending to Postal Review 

1. Update “Task” field in Smartsheet to “Postal Review” 

2. Place files in Postal Review Bin 

a. Located in Data Processing Area along East wall 

b. Supply final size proofs for review 

3. Send postal email 

a. Subject: POSTAGE -->JOB | CUSTOMER | DESCRIPTION 

b. To:  Data-Processing BP 

c. Message: DP Reports Link:  

{Add link to job folder’s reports folder where 
all SOF contents are stored} 

 
CSR Reports to be posted to:  

{Add link to location where SOF contents are to 
be posted for CSR} 

 
INPUT QTY:  

{Postage Info generated from PADME}   
 

Example: 
 

    
 

**Message should be: 
Font: Courier New 
Size: 11pt 
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Preflighting Customer Data 
Preflight Data 

1. Convert data files into delimited files 

a. Tabbed-Delimited 

b. Comma-Delimited 

c. Excel files do not work within Inspire Designer 

2. Save converted data files within DATA_IN folder 

3. Open XXXXXX_PREFLIGHT_DATA_REPORT.wfd 

a. Update JobInfo Module 

i. Add current job number to end of path found within the Default column 

1. F:/CV1/5664234/XXXXXX 

b. Load in data within INPUT FILE module 

c. Within Input file, select the three dots (…) to the right to browse for data 

d. Browse and select the data file 

e. Within file type, select Auto Detect 

f. Open Properties tab 

g. Select Auto Detect button 

i. Ensures fields are updated and pulled in correctly 

h. Open COUNT FIELDS module 

i. Select all fields within the Field Converter column 

ii. Select drop down arrow 

iii. Select “delete” 

iv. Select only fields needed to count 

v. Update Field Converter column back to “None” 

i. Run Production 

i. Workflow toolbar > Run Production 

1. Shortcut = F5 key 

ii. Update Driver Config to v3 – Input Data Report (PREFLIGHT) 

iii. Select “Run on remote server” 

iv. Select Start 
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ii. Items to include in email: 

1. Link to reports folder containing signoff reports requested 

2. Link to where signoffs are to be posted for CSR 

a. Files should not be posted until after SSOE and Postal Review 

3. Postage information 

a. File output from PADME 

i. XXXXXX_POSTAGE_INFO.txt 

e. Job jacket with all hard copy signoffs and reports placed into SSOE bin 

f. Job status on Smartsheet updated to SSOE with DP Operator cleared out 

 

Performing SSOE 
1. Review Data Processing Schedule sheet on Smartsheets 
2. Update the DP Operator column to the operator that will perform the SSOE 
3. DP Operator collects job jacket from SSOE bin 
4. Clock into the job number under the activity code 245051180 (DP File Processing) 
5. Review SSOE email that was sent out 

6. Open job folder the job was processed under 

7. Locate and open the checklist found within the DP_REPORTS folder 

a. XXXXXX_DP059 Second Set of Eyes Checklist.docx 

8. Work through the checklist 

a. Mark off anything completed 

b. Make notes of any issues/concerns found 

9. If issues are found, reply to SSOE email with items found and return to original operator 

a. Original operator to address issues found 

b. If original operator is unavailable, SSOE programmer will make the necessary changes and 
continue routing job 

10. Once SSOE is approved, route to Postal Review 

a. Note: Some jobs do not need to be postal reviewed. 

i. U:\DP-Lettershop\PA_Exemption_List.xlsx 

b. Place job jacket in Postal Review bin 

c. Remove name from DP Operator column in Smartsheet 

d. Update Task from SSOE to Postal Review 

11. Clock out of job and add “SSOE” within the comments section 
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j. Review documents output 

i. Within job folder, open DP_REPORTS folder 

ii. Locate files output 

1. XXXXXX_PREFLIGHT_COUNT.pdf 

2. XXXXXX _PREFLIGHT_DATA.pdf 

3. XXXXXX _PREFLIGHT_DIACRITIC.pdf 

4. XXXXXX _PREFLIGHT_DIACRTIC_REPORT.txt 

a. If no diacritics found within data, DIACTRIC files above will not be 
created. 

k. Review files 

i. Ensure data integrity  

ii. If issues/concerns arise, address accordingly 

iii. Fix/remove diacritics as necessary 

1. Inkjet jobs cannot handle diacritics 

 
 
 

  

file://bp-file01/Groups/InterDeptFolders/DP-Lettershop/
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SSOE 
Second Set of Eyes (SSOE) is a quality check procedure to ensure the job was completed accurately per 
the job ticket and ENPOINTE standards. 

SSOE’s will take precedence over full job setups or edits, unless otherwise indicated by DP Management. 

Sending to SSOE 
1.   In order to send to SSOE, first make sure the following has been done: 

a. All files output from Inspire Designer 

i. SOF 

ii. STA 

iii. MR 

iv. AP 

v. SAM 

vi. Final Dumps 

vii. Proof Labels 

b. Hard copy signoff proofs output 

i. At least 1 of each version 

ii. 1 additional proof, cut down to final size for postal review 

iii. Color proofs if requested 

c. Production reports 

i. XXXXXX_Print_FileSplit_Counts.pdf 

ii. XXXXXX_PRODUCTION_QC_REPORTS.pdf 

d. SSOE email sent 

i. Basic Template: 
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Create List in BCC 
1. Launch BCC Mail Manager 

2. Create New List 

a. File > New List… > Use Template > BCC GENERIC JOB TEMPLATE 

i. Keyboard shortcut = Ctrl + Alt + N 

b. Locate current job folder within the Save New List As window 

c. Update file name to be current job number 

d. Select “Save” 

e. Add any extra fields if needed 

f. Once desired fields are added, select “Save Layout” 

g. Update List Description 

i. JobNumber | CUSTOMER | SHORT DESCRIPTION 

3. Import Data 

a. File > Import List… > New > Browse 

i. Keyboard shortcut = F8 key 

b. Locate and select the data file to import 

c. Select “Next” 

d. Confirm > OK 

4. Specify fields 

a. Drag and drop fields into the appropriate locations 

b. Be sure to also add to In Source fields to keep original data 

c. GLSORIGID – calculated expression 

i. Load 

ii. Uncheck Current List Only 

iii. GLSORIGID 

d. MailerID – STATIC = 107375 

i. IF TRACK & TRACE 

1. NO MAILERID 

ii. Confirm job ticket if another mailerID is to be used instead 

e. InRecord 

i. Right click > Enter > Source Record 

f. InFileName 

i. Right click > Enter > Source Filename 
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e. Go to Job Center tab in uProduce 

i. Locate job submitted from previous step 

ii. Wait for Status column to update to green check 

1. May need to refresh the page 

iii. Once green, select the check mark 

1. This will begin to download the file 

 

7. Collect & Move output files 

a. Go to the Downloads folder on your computer 

b. Locate the files downloaded from uProduce 

c. Cut and paste them into the current working job folder within the appropriate subfolder 

 
  

Data Processing Workflow 
Standard Work  
 
 
DP050 Rev. 0 

 

Page | 9 

  

 

g. Select “Skip First Record” 

h. Open Options tab 

i. Select “Scan” button to check for longest fields and field assignments for truncation 

j. Select “Auto-Size Output Fields” if needed 

k. Select “Import” 

l. Within Enter Description window, select “Don’t Save” 

m. Update Text File path within the Select Report Destination Window 

i. F:\CV1\5664234\XXXXXX\DP_REPORTS\ImpRept.txt 
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iv. Imposition: 

1. Only update when outputting imposed files for press. Keep disabled if 1-
up imposition is needed. 

2. Imposition Template: Cut and Stack 

a. Reference job ticket 

b. Update: 

i. Sheet Dimension (found on job ticket) 

ii. Margin = 0.375” (adjust as needed) 

iii. Select “Calculate” button 

1. Confirm number up matches job ticket 

iv. Mark the following: 

1. Duplex 

2. Center Pages on Sheet 

3. Draw Cut Marks 

a. Values are the bleed (0.125) 

 

d. Select Submit 
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Run CASS 
1. Postal toolbar > ZIP+4 Encode… > Encode Selected Records 

a. Keyboard shortcut = Ctrl + K 

i.   
2. Update Printer to Win2PDF within the ZIP+4/eLOT encoding Parameters window 

3. Select OK button 

4. Update Printer to Win2PDF within PS Form 3553 – CASS/NDI Report – Print window 

5. Select OK button 

6. Select I Agree within the Dan Prairie Systems LLC window 

7. Locate current job number DP_REPORTS folder and save PDF within 

8. Review PDF output 

a. Review percentages found in the National Deliverability Index section at the end of the 
PDF 

i. Addresses ZIP+4 matched and standardized: 90+%   

ii. Addresses with apt/ste number matched to building record: 60+% 

iii. Addresses with correct 5-Digit ZIP Code: 98+% 

b. If percentages fall under standard, PADME will fail 

c. Notify CSR and ask how they would like to proceed 

i. If okay to continue, make note of lowest percentages 

1. Will need to update option within PADME 
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ii. Range 

1. Select All 

a. Update “Split job to:” if needing to split out PDF for press 

 

iii. Production and Deployment 

1. Output Format: PDF/VT-1 

2. Output File Name: Custom 

a. Job#_BATCH_FileType_RevisionNumber 

i. 999999_PKG1_SOF_R1 

ii. 999999_MAIL_AP_R1 
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Run NCOA 
1. Postal toolbar > Data Services > Create Job… 

a. Keyboard Shortcut = Ctrl + B 

b.  
2. Select NCOALink FSP 

3. Select Prepaid/Subscription 

4. Select Next 

5. Continue selecting Next until page 5 within the Data Services Wizard 

6. Update PO Number to current job number 

7. Select Next 

8. Locate your list  

9. Choose PAF 

10. Select Next 

11. Update Class of Mail 

a. Select First-Class 

b. Select Standard 

c. Update Mailing ZIP Code = 55121 

12. Select Finish 

13. Update Save to*: path to current job folder 

a. F:\CV1\5664234\XXXXXX\NCOA\ 

14. Select Next 
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5. Upload data to uProduce 

a. Return to campaign on uProduce server 

b. Go to Data Sources section within your campaign 

 

i. Select New 

ii. Update Data Source Type to “Separated Values Text” 

iii. Load in your data file 

1. Either select “Choose File” and locate your data file or if the folder is open 
in File Explorer, drag and drop onto the “Choose File” button to load file 

iv. Update delimiter as necessary 

v. Select Save 

vi. Repeat for all data sources 

6. Output from uProduce 

a. Go to the Documents section within your campaign 

b. Select your InDesign file 

c. Select Process 

i. Recipients  

1. Update Recipients Data Source to desired data 

2. Select the Table associated with the data source 
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Remove Undeliverables 
1. Close list in BCC Mail Manager 

2. Run POSTASS.exe 

a. Enter Job# 

3. Open list again in BCC Mail Manager 

4. Remove Undeliverables if necessary 

a. Navigate toolbar > Selectivity 

i. Keyboard shortcut = Ctrl + S 

b. Select POSTCASS – AGGRESSIVE within the Choose Selection Set window 

c. Select “Use” button 

d. Export List 

i. File > Export List… 

1. Keyboard Shortcut = F9 key  

ii. Select New 

iii. Update Export File Type to Delimited 

1. Unless Excel file is requested on Job Ticket 

iv. Update path and file name accordingly 

1. F:\CV1\5664234\XXXXXX\XXXXXX_UNDELIVERABLES.csv 

v. Select Export 

vi. Repeat, while updating File Type to dBase/FoxPro 

1. F:\CV1\5664234\XXXXXX\XXXXXX_UNDELIVERABLES.DBF 

vii. Confirm Two Files output 

1. CSV/Excel file 

2. Database file (DBF) 

e. Delete Records 

i. Maintenance toolbar > Hide Selected Records 

1. Keyboard shortcut: Ctrl + Del 

ii. Maintenance toolbar > Delete Hidden Records 

1. Keyboard shortcut: Ctrl + F8 
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h. Cycle through records to ensure scripting is correct 

i. Troubleshoot any errors 

i. Consult a team member if any guidance is needed 

4. Once everything is in check, upload to uProduce 

a. With InDesign open, go to Dynamic Content  Save to Server… 

 

b. Update Account to correct customer 

c. Update Campaign to the one created in Step 3. (Should be current job number) 

d. Update Document Name to something descriptive for the job 

i. Can be Job#_XMPie or Job#_Description 

1. Examples: 

a. 999999_XMPie 

b. 999999_Postcard 

e. Update Fonts to “Upload New Only” 

f. Update Data Sources to “Don’t Upload” 

g. Update Assets to “Upload New Only” 

h. Select Save 
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Merge/Purge Duplicate Elimination 
1. Review job ticket to ensure dedupe requested 

2. Complete CASS & NCOA & remove undeliverables 

a. CASS 

b. NCOA 

c. UNDELIVERABLES 

3. Open list in BCC Mail Manager 

4. Open Enhanced Merge/Purge window 

a. File > Enhanced Merge/Purge… 

i. Keyboard shortcut: CTRL + ALT + Y 

5. Select “New” 

6. Choose desired Saved Merge/Purge Types 

a. Generally, choose NAME ADDRESS KEEP SEEDS (85) 

i. Will merge multiple records to the same address into one record, addressed to 
the household.  Includes delivery address only.  Matches with a minimum score of 
85 

b. If ticket specifies “Exact” or “one record per address” choose NAME ADDRESS KEEP 
SEEDS (100) 

i.  
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2. Create job on uProduce server 

a. Go to uProduce server (http://bp-xmpie01/XMPieDashboard/Login.aspx)  

i. Within Accounts 

1. Locate Client folder 

2. If Client folder doesn’t exist 

a. Select “New” 

b. Enter the Client’s name found on the job ticket in the “Name” section 

c. Select all Data Processing operators in the “Share Account” section 

d. Select “Save” 

ii. Once Client folder is located, select and open to Campaigns section 

iii. Within Campaigns  

1. Locate Job# folder 

2. If Job# folder doesn’t exist 

a. Select “New” 

b. Enter the job number found on the job ticket in the “Name” section 

c. Enter the job description found on the job ticket in the “Comments” 
section 

d. Select “Save” 

3. Create InDesign file for XMPie 

a. Locate InDesign file(s) on Premedia server 

b. Copy all InDesign files, link folders, and document fonts folder 

c. Paste into current job XMPIE folder 

d. Open all InDesign files 

i. If more than one InDesign file, compare all elements 

e. Merge InDesign documents into one 

i. Use layers to differentiate specific versions 

ii. Try to create a common layer for certain elements 

f. Once InDesign is organized and merged, link the data 

i. Dynamic Content  Link to Data Source 

g. Update variables as needed 
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c. Edit Merge Type if applicable 

i. Add additional MatchCodes/Indexes specified on job ticket to dedupe by 

d.  
7. Select List for Merge/Purge 

a. Locate opened list (should be shown bolded within the list) 

b. Update Output File Name 

i. F:\CV1\5664234\000000\000000_M1.dbf 

8. Select Next x2 

9. Reset Field Mappings 

a.  

http://bp-xmpie01/XMPieDashboard/Login.aspx
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XMPie 
XMPie Workflow 

1. Output data for uProduce 

a. Open List in BCC Mail Manager 

b. Define Labels 

i. Labels/Reports > Define Labels… 

1. Keyboard shortcut: F5 key 

ii. Select “New from Template” 

iii. Locate and select the template “XMPie – General” 

iv. Within the Label Designer 

1. Adjust the number of lines 

a. Label > Label Properties 

b. Select Printer or File tab 

c. Update the Label height to the desired number of lines 

d. Select “Apply” and then “OK” 

2. Add all variables that will need to be applied within the art/design 

a. Locate field within the list on the right side 

b. Drag and drop onto label lines 

3. Double click the first line with the variable “Intelligent Mail Barcode” 

a. Verify the following 

i. Mail Class/Piece Type: {Standard Mail} 
1. Update according to presort settings found on job ticket 

ii. MailerID: 107375  
1. Unless specified otherwise on job ticket 

iii. Serial Number: [IMB_SEQ] 

4. Save the label 

a. File > Save As… 

v. Select the label created and choose “Use” 

c. Open Presort Settings 

i. Choose desired batch to output – double click 

ii. Print > Labels 
1. Keyboard shortcut: CTRL + ALT + L 

iii. Save in job folder XMPIE subfolder 

iv. Update file name to {BATCH} 
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10. Select Next 

11. Specify the location by updating the job number as seen below 

a.  
12. Select Next 

13. Select Save 

14. Select Merge 

a. New BCC List created with all Dupes removed 

b. Dupes report generated and placed into DP_REPORTS folder 

c. DBF created containing all the duplicate records found for reference 

  

file://bp-file03/dp/DP%20Common/BCC/FS/Templates


Data Processing Workflow 
Standard Work  
 
 
DP050 Rev. 0 

 

Page | 33 

  

 

5. Output STAs 

a. Run Production 

i. Workflow toolbar > Run Production 

1. Shortcut = F5 key 

ii. Check “Run on remote server” 

iii. Update Module to Final_PDF 

iv. Update Driver Config Profile to v3-Prod Dir Out 

1. This will route files directly to your production folder 

v. Update Workflow Parameters 

1. File type to process = “STA” 

2. Batches = “ALL” or specified if needed 

vi. Select Start 

6. Output MR/SAM/AP 

a. Run Production 

i. Workflow toolbar > Run Production 

1. Shortcut = F5 key 

ii. Check “Run on remote server” 

iii. Update Module to Imposed_PDF 

iv. Update Driver Config Profile to v3-Prod Dir Out 

1. This will route files directly to your production folder 

v. Update Workflow Parameters 

1. File type to process =  

a. “MR” 

i. Make Ready 

b. “AP” 

i. Live Production Files 

c. “SAM” 

i. Samples 

2. Batches = “ALL” or specified if needed 

vi. Select Start 
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Update Data Casing 
1. Review job ticket for casing preference  

2. Maintenance toolbar > Modify Selected Records 

a. Keyboard shortcut: Ctrl + Y 

3. Select New 

a. Update fields accordingly 

i. Select multiple at a time while holding SHIFT 

ii. Right click fields > Filter Characters 

iii. Update Convert Case accordingly 

1. aS Is 

2. Mixed 

3. UPPER 

4. lower 

iv. Select OK button 

v. Select Begin button 

vi. Select Don’t Save button 

 
 

 

Assign IMB Barcode 
1. Close list in BCC Mail Manager 

2. Launch the IMBRangeRequester (Do not run if Track and Trace) 
a. Browse for your XXXXXX.dbf file 

b. Update Job Number = Current job number 

c. Update Sequence Number Field = IMB_SEQ 

d. Select Submit File button 

3. Open list again in BCC Mail Manger 

4. Verify IMB_SEQ populated 
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Outputting Files from Inspire Designer 

Outputting Files 
1. Output QC Reports 

a. Run Production 

i. Workflow toolbar > Run Production 
1. Shortcut = F5 key 

ii. Uncheck “Run on remote server” 

iii. Select Start 

2. Load QC Reports that output in DP_REPORTS folder 

a. Select STAT_SELECTS module 

i. Load in “…STAT_SELECTS.txt” 

b. Select SOF_SELECTS module 

i. Load in “…SOF_SELECTS.txt” 

3. Update ImposInfo Module 

a. Reference job ticket to update information 
i. Sheet Width 
ii. Sheet Height 
iii. DutchCut 
iv. HeadLeft 
v. Bleed 
vi. Center 

1. TRUE if Indigo 7500 or vWeb 
vii. UseHunkler 

1. TRUE if vWeb 
viii. SheetInfo-Rotate 

1. If content overlaps sheet information, update to rotate to avoid 
4. Output SOFs 

a. Run Production 

i. Workflow toolbar > Run Production 
1. Shortcut = F5 key 

ii. Check “Run on remote server” 

iii. Update Module to Final_PDF 

iv. Update Driver Config Profile to v3-Job Report Dir Out 

1. This will route files directly to your XXXXXX_REPORTS folder 

v. Update Workflow Parameters 

1. File type to process = “SOF” 

2. Batches = “ALL” or specified if needed 

vi. Select Start 
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Run Presort 
1. Postal toolbar > Presort Active List  

a. Keyboard Shortcut = Ctrl + P 

b.  
2. Update the presort information accordingly, referencing job ticket 

a. Class of Mail 

b. Piece Type 

c. Mail Stream 

d. Piece Dimensions 

i. Weight 

ii. Thickness 

iii. Length 

iv. Height 

e. Permit 

f. Mailing Dates 

g. Advanced Settings 

i. Pallet Options tab 

1. LETTERS MM TRAYS = min 6 max 10 

2. LETTERS EMM TRAYS = min 6 max 8 

3. FIRST CLASS FLAT TUBS = min 2 max 4 

4. STANDARD FLATS = Use Hight (in) = 65” 

ii. Carrier Route Options tab 

1. Check Ignore DDU Minimum 

2. Update Min CR Pack Size = 999 

iii. Mailing tab 

1. Full-Service Participation 

a. Full Service 

b. Basic 

i. Locate information on job ticket 

h. Select OK button 
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Letter Setup 
Format for Press 

1. Select desired GMC template 

a. F:\CV1\5664234\GMC_TEMPLATE 

i. VARIABLE_PRINT_FINAL_STEPS_0.0.wfd 

1. Indigo, VWEB, Laser 

ii. INKPREP_FINAL_STEPS_0.0.wfd 

1. Inkjet 

2. Copy WFD into job folder 

3. Rename with job number at beginning 

a. XXXXXX_VARIABLE_PRINT_FINAL_STEPS_0.0.wfd 

b. XXXXXX_INKPREP_FINAL_STEPS_0.0.wfd 

4. Open WFD 

5. Update JobInfo module 
a. Job# and paths 
b. Customer 
c. Description 
d. Operator 
e. Address Fields 
f. Stat fields 
g. Quantities 

i. Sample 
ii. Blank Sample 
iii. Dupes (LIVE) 
iv. Signoff 

6. Load in Data 
a. Open Internal Data Input Module 

b. Browse and select current job .tsd file created from PADME 

7. Format Data if needed 

8. Update Layout Module 
a. Add Art & Assign Variables specified on job ticket 

b. Update Page Sizes accordingly 

c. Locate SHELLS found within DP_ART folder 

d. Bring into layout and adjust positioning to match client’s original art 

e. Update fonts accordingly 

f. Ensure: 

i. Images are loaded with transparency, native, and place native image in overlay 

ii. No overprint is set 

iii. Include fonts/images 

1. File > Used Files 
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i. Output SELECTS 

i. Sort “Auto” column 

ii. Save SELECTS within DP_REPORTS folder 

iii. XXXXXX_SELECTS.xlsx 

iv. Send SELECTS email 

1. To: 

a. Elizabeth McMullen  

b. Luis Jimenez  

c. Anthony Young  

2. CC:  

a. Data Processing-BP 

3. Subject: 

a. SELECTS --> JobNumber | CUSTOMER | Short Description 

4. Message: 

“Please let me know which selects to use. 

Thank you” 

5. Attach excel file 

v. Wait for response 

1. If Local Entry, no need to rerun presort 

j. Rerun Presort settings 

i. Load Last Used settings 

ii. Select OK button 

iii. Select specified SELECTS accordingly 

3. Close BCC Mail Manager 

 

 
 

 

 
 

  

file://bp-file03/DP_Production/dp/g2v1/CV1/5664234/GMC_TEMPLATE
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Run PADME 
1. Open PADME.wfd found within DP_REPORTS folder 

2. Update PADME PARAMS accordingly 

a. Batch (ALL, RECENT, <BATCH>) 

i. Separate batches by mail.dats if necessary 

1. mail.dats can only span 30 day 

b. Mail Date 

c. Payment method (Permit/meter/stamp) 

d. MarkRecords (Basic, Full, TnT, TnT-Basic, Parcel, STID_* or None) 

e. CNT by ZIP: Yes 

3. Load in Mail file 

4. Load in Undeliverables 

5. Load in any dedupe files or suppressed 

6. Run Production 

a. Workflow toolbar > Run Production 

i. Shortcut = F5 key 

b. Uncheck “Run on remote server” 

c. Select Start 

d. Wait 

i. Creates: 

1. AP data file 

2. Postage info 

3. Qual reports 

7. Troubleshoot any errors 

a. Locate and open .log files found within PADME_FILES folder 

b. Troubleshoot any specified errors 

c. Rerun PADME 

8. Review files 

a. Postage Info 

b. JSU 

c. Mail.dat files 

9. Post to Dameon if files are correct 

10. Close Inspire 
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Track N Trace (TNT)  

1. Check job ticket postal presort options to confirm Track N Trace. 

2. Ensure MailerID field is empty within BCC Mail Manager 

3. Presort job  

4. After presorting, reopen the presort screen and select desired batch 

5. Select the Track N Trace Wizard 

a. Tools > Track N Trace 

i. Keyboard shortcut: CTL + T 

6. Select “Create a new job for the current mailing” 

a.  
7. Fill out the following on the Detail Screen: 

a. Your Job ID 

i. Enter the job number 

b. Your Job Title 

i. Enter a description 

ii. Do not include Customer name 

iii. If there are multiple batches, add “-“{Batch Name} at the end of description to 
differentiate between them 

1. Do not need to include if only one batch 
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NonTNT IMpB  

Mark Records - IMpB 
1. Run Presort Beforehand 

2. Pick up taskmaster script: 

a. F:\BCC\FS\Jobs\MARK RECORDS_IMpB_PriotityParcel.mjb 

3. Save into C:\BCC\FS\Jobs 

4. Open in UltraEdit 

a. Find & Replace and update the job number accordingly 

b. CTL + R 

i. Find what: 000000 

ii. Replace with: (Your current job#) 

c. Save the changes 

5. Open job list in BCC 

6. Open TaskMaster Job List 

7. Run “MARK RECORDS_IMpB_PriotityParcel”  

a. Should mark IMpB fields needed 

b. Should output Presort Reports 

Create Mail.Dat 
1. Pick up settings 

a. F:\BCC\FS\Settings\MailDat\IMPB_MAILDAT.mds 

2. Save into C:\BCC\FS\Settings\MailDat 

3. Open job list in BCC 

4. Open presort settings 

5. Select Saved Presort & Click Use 

6. Select Generate Mail.dat file set 

7. Load in IMPB_MAILDAT.mds 

8. Go through the Mail.dat wizard, updating job# and dates accordingly 

9. Copy Mail.dat over to the network 

10. Post to Daemon 
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c. Mailing Date 

i. Enter mailing date found on job ticket 

d.  
e. If piece contains “CHANGE SERVICE REQUESTED” or “RETURN SERVICE REQUESTED”, 

jump to page 5 for additional instructions 

8. Verify if Dropship on the Shipments screen 

a. If not dropship, only one drop date should be available 

b. If job is dropship, select all and update drop date to the same mail date 

c.   

file://bp-file03/DP_Production/dp/g2v1/BCC/FS/Jobs
file://bp-file03/DP_Production/dp/g2v1/BCC/FS/Settings/MailDat


Data Processing Workflow 
Standard Work  
 
 
DP050 Rev. 0 

 

Page | 28 

  

 

7.  ONTRAC will then process files and repost to FTP 

a. J:\Open_Access\ontrac\Data 

8. ONTRAC will notify via email once completed with quote and indicia’s if requested 

9. Pick up data and paste into current job number working folder 

10. Continue with setup accordingly 

 

***IMPORTANT NOTE*** 
Once DP has provided proofs, the proofs for the Canadian or Foreign records  

MUST BE APPROVED BY ONTRAC, before sending proofs to CS. 
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9. Update Billing Method to Premium Credits on the Billing screen 

a.  
10. Update Mail Piece Information screen 

a. Select “Send name information combined format” 

b. Add in a variable field if applicable within the User-defined field 

i. Select checkbox next to “Number 1” 

ii. Right click 

iii. Add desired variable field 

c.  
 

file://bp-servuftp/glsftp/Open_Access/ontrac/Data


Data Processing Workflow 
Standard Work  
 
 
DP050 Rev. 0 

 

Page | 27 

  

 

6. Send email to ONTRAC 

To:  Tim Schwarzrock (TSchwarzrock@OnTrac.com) 

Cc:   Data Processing-BP, {CSR} 

Subject:  Customer | Description | ENPIONTE Job # JobNumber 

Message: 

Hi Tim, 

 

Files posted:  

J:\Open_Access\ontrac\From_ENPOINTE\000000\000000_TO_ONTRAC.zip 

  

File names: 

000000_FOR_TO_ONTRAC.csv 

000000_CAN_TO_ONTRAC.csv 

  

MAILING SPECS 

Size:                    0x0 letter 

Thickness:           0.00 

Weight:                0.00 

Mailing:               Canada Post Lettermail 

Mail date:            X/XX/XX 

  

{Indicia’s not necessary – ONTRAC to apply once live pieces are received.} 

{Please send back appropriate indicia’s} 

  

Thank you 

 Note: The purpose for this is that ONTRAC will reply all which saves DP having to send postage info to CS. 

• Included in the subject line of the email is the customer’s name and job title (some customers get a better 
postage rate so customer name is important to include) 

• Include weight, thickness, estimated mail date and how it is mailing or a request to provide the best mailing 
option (There are times that ONTRAC will ask about the return address, as in, if the piece has one or if it is US 
or if it is Canada.  These will help determine the correct indicia to provide) ***Note, all of this information will 
be entered into the ONTRAC script on the ticket by Client services. 

• Request indicia or let ONTRAC know the project will meter 
• Include any data split or processing instructions needed 
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11. Update the Service Bureau screen 

a. Select existing mail group 

i. Ticket should list which customer to select in the presort instructions 

b.  
12. Select Next 

13. If additional batches, return to Step 4 

 

 

 

 

 

 

 

 

 

 

 

 

 

mailto:TSchwarzrock@OnTrac.com
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ii. If Additional Foreign Records 

1. COUNTRY <> CANADA  

2. COUNTRY = Not Empty 

3.  
c. Select Use 

4. Once selectivity is chosen, export selection 

a. File > Export List… 

i. Keyboard Shortcut = F9 key 

b. Select New 

c. Update the following: 

i. Export File Type: Delimted (e.g., comma) 

ii. This will export the current list to the following file: 

1. F:\CV1\5664234\000000\000000_CAN_TO_ONTRAC.csv 

a. For Canadian records 

2. F:\CV1\5664234\000000\000000_FOR_TO_ONTRAC.csv 

a. For additional foreign records 

d. Select Export 

5. Post files to FTP 

a. J:\Open_Access\ontrac\From_ENPOINTE\000000 

i. Create job number folder to post exported data into 

ii. Zip files together - 000000_TO_ONTRAC.zip 
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Track N Trace (TNT) + CHANGE/RETURN SERVICE REQUESTED 

1. Confirm with art/instructions on ticket 

a. Piece contains either: 

i. CHANGE SERVICE REQUESTED 

ii. RETURN SERVICE REQUESTED 

2. Update the following on the Detail Screen: 

a. Check “Ancillary Service Endorsement 

b.  
3. Return to step 8 on page 18, continuing TNT wizard as normal 

4. Once TNT wizard is completed, open Labels menu 

a. Labels/Reports > Define Labels 

i. Keyboard shortcut: F5 key 

5. Select “New from Template” 

6. Locate template titled “mark records – TRACK N TRACE” 

7. Select OK 

8. Open Label Properties 

a. Label > Label Properties 

9. Open Mark Records tab 

10. Locate “IMB”, right click, and choose Properties 
 

 

file://bp-servuftp/glsftp/Open_Access/ontrac/From_ENPOINTE
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ONTRAC 

1. Verify if ONTRAC processing is requested on job ticket 

a. Splits out any Canadian and Foreign records 

2. Open List within BCC Mail Manager 

3. Choose Selectivity to Export data 

a. Navigate > Selectivity 

i. Keyboard Shortcut: CTRL + S 

b. Create New selection Set 

i. If CANADA records: 

1. COUNTRY = CANADA 

2.  
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11. Update Properties as followed: 

a. Check “Use Track N Trace Intelligent Mail barcode information” 

b. Verify “Ancillary Service Endorsement” box checked in the locked-out Services section 

c. Verify the information populated in the Serial Number Range box 

i. Cross-reference against the TNT confirmation email 

1. Verify correct range is applied 

d.  
12. Run Track N Trace Label to generate IMB within BCC 

13. Confirm STID and IMB Sequence numbers are accurate 

a.  
14. Continue to PADME 
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